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Seventh Edition (March, 2002)

The information contained in this document has not been submitted to any formal IBM test and is distributed on an
“as is" basis without any warranty either express or implied. The use of this information or the implementation of
any of these techniques is a customer responsibility and depends on the customer's ability to evaluate and integrate
them into the customer's operational environment. While each item may have been reviewed by IBM for accuracy
in a specific situation, there is no guarantee that the same or similar results will result elsewhere. Customers
attempting to adapt these techniques to their own environments do so at their own risk.

Comments concerning this notebook and its usefulness for its intended purpose are welcome. You may send
written comments to:

IBM Canada Ltd.
8200 Warden Avenue, Markham, Ontario, L6G 1C7
Attention: Inge Weiss, CODE/400 Advanced Topics

or e-mail to: iweiss@ca.ibm.com

Technical Information

For more technical information on CODE/400 or WebSphere Development Tools for iSeries contact either
Dave Slater at slater@ca.ibm.com
Claus Weiss at weiss@ca.ibm.com

Education

CODE/400 courses:

S6186 CODE/400 for iSeries - Basic (2 days)
S6205 CODE/400 for iSeries - Advanced (1 day)
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Overall Lab Guide

The objective of the lab CODE/400 - Selected Advanced Topics is to explore some
of the customization possibilities that are available in the CODE Editor. At the end of
the lab, the student should know how to create REXX macros, menu items, toolbar
buttons, and popup menus. The Lab also shows how to make these changes
persistent by adding them to the appropriate editor profile. Part two of this lab shows
how to create an Lpexlet, an extension to the editor written in Java.

The exercises require that all steps are completed successfully in sequence.

Note: The pictures in these labs show similar tasks. Some of the names and

directories may be different from the environment you are working with.
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Prerequisites

The participants should be familiar with CODE/400. They should be able to use the
CODE Editor. Also, it is helpful if the student is familiar with basic MS Windows
operations such as working with the desktop and basic mouse operations such as
opening folders and performing drag-and-drop operations.
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Introduction

The IBM WebSphere Development Studio for iSeries product is a suite of e-business enabling
technologies including host and workstation components:

Host Components

* ILERPG

* |ILE COBOL
* ILEC

* |ILEC++

Application Development ToolSet

Workstation Components

*  WebSphere Studio for iSeries
*  WebFacing

* VisuadAge RPG

* CODE

* VisualAge for Javafor iSeries

The CoOperative Development Environment, better known as CODE, is a set of integrated
development tools that allow you to: create, edit, compile, and maintain your source code; debug

programs using a PC connected to an iSeries; and completely organize your programming
projects.

The CODE product includes the following tools:

* CODE Editor
A powerful language-sensitive editor that you can easily customize. Token highlighting of
source makes the various program elements stand out. It has SEU- like specification
prompts for RPG and DDS to help enter column-sensitive fields. Local syntax checking
and semantic verification for your RPG, COBOL and DDS source makes sure it will
compile cleanly the first time on aniSeries. If there are verification errors, an Error List
lets you locate and resolve problems quickly. On-line programming guides, language
references, and context-sensitive help make finding the information you need just a
keystroke away.

* CODE Program Generator
Aninterface that allows you to submit requests to the iSeries to compile, bind, or build
objectson the host. The tool gives you easy access to all the compile options available for
all the supported create commands (CRTxxXx).

* CODE Desgner
A rich graphical interface that makes designing or maintaining display file screens, printer
file reports and physical files easy and fun.

* CODE Debugger
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A source-level debugger that allows you to debug an application running on a host iSeries
from your workstation. It provides an interactive graphical interface that makes it easy to
debug and test your host programs.

* CODE Project Organizer
An enhanced and more flexible workstation version of the Program Development Manager
(PDM). It tiesall the parts of CODE together and allows you to quickly access al the
power of CODE and to effectively manage and organize your development projects.
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The Goal

In this session, you will learn some nontrivial features and functionality of the CODE tools. You
will learn how to customize the LPEX editor by using predefined functions and extending its
capability with REXX macros and Java Lpexlets. Y ou will also find out how productive you can
be with CODE even when there is no connection to the iSeries host. We are confident that CODE
will save you time and effort in your day-to-day programming tasks. It will make you a more
efficient and effective programmer. At the same time, it will save cycles on your iSeries. Now let’s
spend a couple of hours playing and see if you agree.

The Tool

Installing CODE
The CODE tool of the WebSphere Development Studio for iSeries (WDS/400) product consists
of two parts:
1. The ‘back-end’ which resides on the iSeries.
This part is responsible for handling all the workstation requests such as getting or saving
source members, etc. The back-end is shipped with the WDS product.
2. The‘front-end’ which isinstalled on your workstation.
These workstation files can be installed from:
* alocal CD drive
* aL AN drive (assuming that an installable image has been set up on the LAN)
* aniSeries (assuming that the workstation files have been copied into the iSeries ifs).
The workstation install uses the Windows Installer.

The minimum hardware requirements for CODE are an Intele Pentium |1 processor or faster with
64MB of memory, a SVGA 800 x 600 monitor, CD-ROM drive, and a mouse or pointing device.
The recommended workstation hardware is a processor with 96MB of memory, and a SVGA
1024 x 768 monitor. A complete install of CODE including the help files uses about 235MB of
disk space.
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The Lab = Section 1: Customizing the
CODE Editor

Section I ntroduction

Basic Editor Features

The CODE Editor has al the basic functions that you would expect in any serious editor:
* Cut, copy, and paste
* Block marking of lines, characters, or rectangles with copy, move, overlay, and delete
operations.
* Powerful find and replace functionality.
* Unlimited undo and redo.
* Automatic backup and recovery.

In addition there are afew more functions that you may not have seen in aworkstation editor:
* Token highlighting -- different language constructs are highlighted using different colors and
fonts to help identify them in a program. This highlighting is completely customizable (see the
menu item Options> Token attributes...).
* SEU- like format-line rulers to show the purpose of each column for column-sensitive
languages like RPG and DDS. These rulers can automatically update themselves to reflect the
current specification.
* SEU-like specification prompting for RPG and DDS.
* Sequence numbers which allow SEU-style commands in the prefix area
* Intelligent tabbing between columns for column-sensitive languages.
* Automatic uppercasing for languages that expect uppercase (RPG and DDS).
* For column-sensitive languages there isthe CODE FIELDS ON command that simplifies
text insertions and deletions.
* On-line language reference help.

Editor Programming (ultimate customization)
Despite its rich functionality, the CODE editor may still lack features that suit the needs of a
particular iSeries shop, or even individual programmers. Therefore, we provide a means of
customizing the editor to your liking. Y ou can:
*  Specify default editor settings.
* Add editor functions and your own macros to the menus and toolbar.
* Assign/re-assign keys and/or line commands to editor functions and your own macros.
* Interact with the host viathe CODESRV command.
* |Implement and execute REXX macros and Java L pex|ets.
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In this section we will introduce you to:

* Associating name patterns with source types.

* Associating source types with language profiles.
CODE editor commands.

REXX macros for the CODE editor.

Adding and updating editor menus and popup menus.
Updating the editor toolbar.

The CODESRV command.

Working with various editor profiles.

Y ou will:

1. Associate the RPGLE file type with all local files that have the extension .RPG.
2. Learn, execute and master various LPEX editor commands.

3. Write and execute the RPGPROC REXX editor macro (that uses a prompt box).
4. Update the editor menu, popup menu, and toolbar.

5. Use CODESRYV to submit remote commands.

6. Understand editor profiles, and create an RPGLE400.L XU profile.

Now let’s begin our journey into the wonderful world of CODE...
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Step 1. Connecting to theiSeries

PURPOSE

Communication between the iSeries and your workstation can be configured for:
*TCP/IP using the native Windows built in TCP/IP support. Y ou can use any 5250 emulator
that supports TCP/IP.
* SNA (System Network Architecture) / APPC (advanced program-to-program
communications). This setup requires either: Client Access Express,; Personal
Communications, or RUMBA to handle the communications.
For this lab session, you will use TCP/IP communications. On the workstation, the CODE
daemon needs to be running in order to allow TCP/IP communication with the iSeries. When your
PC isrestarted after the CODE instalation, the CODE daemon is started for you. If you closed
the daemon or want to start it manually, you can do so from Start - Programs - I1BM
Websphere Development Tools for iSeries > Communications - Communication Daemon.

INSTRUCTIONS
la. Ensure that the Communication daemon is running. = ==
This program waits and listens for an iSeries to contact 10:27 AM

it on a specific TCP/IP port and then makes a connection.
Y ou should see an icon in your system tray (bottom right of your screen).
Y ou can interact with CODE communications by using the pop-up menu of thisicon.

Shukdawrn all servers

Enablehidden messages

Properties..

1b. Start a 5250-emulation session.

1c. Signonto theiSeries. Your userid and password should both be CODEL ABxx where xx
is your workstation number (01, 02, etc.). The Enter key could be the Ctrl key in your
5250-emulation session.

1d. At the iSeries command line type: STRCODETCP. Thiswill call aCL program which
automatically figures out which I P address your emulator is using and invokes the
STRCODE command. Y ou should see a screen that has EVFCL OGO in the upper left-hand
Corner.
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If you did not have this CL program, you could type or prompt the STRCODE command:

STRCODE RMTLOCNAME(PC_hostname) CMNTY PE(* TCPIP)

Start CODE (STRCODE

Type choices, press Enter.

er value

C, *TCPIP

Or you could use the parameter *RESOLVE on the STRCODE command to have the

Code communication resolve the remote location name:

STRCODE RMTLOCNAME(*RESOLVE) CMNTYPE(* TCPIP)

Thisis recommended for TCP/IP DHCP users.

Start CODE (STRCODE)

Type choices, press Enter.

Host serwver name . 2 Character
Remote location name .
Communications type

*PRV,

*APPC,

value

*TCPIP
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Step 2. Associating name patter nswith
sour cetypes

PURPOSE

For the following exercises we will need to create an ILE RPG file and store it on alocal drive.
Most local source files have both a file name and a file extension. The CODE editor uses the file
extension to determine what type of sourceisin thefile. For example, filesthat have afile
extension .RPG are assumed to contain RPG/400 while files with an .IRP extension are assumed
to be ILE RPG. It’s easy for us to change these default settings. In the following exercise you
will associate the name pattern * .RPG with ILE RPG instead of RPG/400.

INSTRUCTIONS

2a. Start the CODE editor from the Windows Start menu. Select Start—-> Programs—> |BM

WebSphere Development Tools for iSeries> IBM CODE400 - CODE Editor. The

CODE Editor appears.

2b. Fromthe editor’s ‘Options menu, select ‘Associations' -> ‘Name pattern’. The
‘Name Pattern Association’ dialog comes up.

i Hame Pattern Aszociation
Harne patterh Source bipe
|*RFG |RPGLE

“RPG
“RFT
*5CH
“5CR
*5IC

=5IR

“50C

ER T

4

ak j Eancelj Help j

2c. From the ‘Name pattern’ list box pick the *.RPG pattern. Select the RPGLE value from
the ‘ Source type’ list box.

2d. Pressthe ‘Change’ button to make the changes take effect.
From now on when we open afile with a .RPG extension, the editor will treat it asan ILE
RPG file.

NOTE: You can associate source types with name patterns for host files as well. For example,
associating a*/QRPGSRC(*) pattern with the RPG source type tells the editor to treat any
member from the QRPGSRC file as an RPG/400 file.
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Now let’s get a bit creative. We will invent a new name pattern called ‘MySource' and associate it
with the CBLLE (which stands for ILE COBOL).

2e. Inthe ‘Name pattern’ entry field type: *.MySource and then select CBLLE from the

‘Source type' list box.

ENEI‘I‘IE Pattern Association

Mame pattern Source type

F MuSource {CELLE

*C ﬂ *MOMNE .

* CBL BAS

2oL BMND

*CLP [

* CMD CEL

* CPa, CELLE

*CPO Jﬂ CICSC

ot CICSCEL

<« r CICSrEl | E =~
5] | Cancel | Help |

X

dd

I

Ehahage

i

Belete

2f. Pressthe *Add’ button to complete the association.

29. Pressthe‘OK’ button to dismiss the ‘Name Pattern Association’ dialog.

If we now create afile with the extenson .MySource, the editor will treat it asILE COBOL.

CODE - Advanced Topics
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Step 3. Associating sour ce types with language
profiles

PURPOSE

In the following exercise you will see the importance of being able to associate name patterns with
source types. The CODE editor gives you the flexibility to execute editor commands and macros
when afile gets loaded into the editor. Moreover, different commands and macros get executed
for different ‘language profiles’. Therefore, it is very important that file source types are
associated with the appropriate language profiles. Guess what, CODE provides you with such a
feature!

INSTRUCTIONS

3a. From the editor’s *Options menu, select ‘Associations -> ‘Sourcetypes. The
‘Source Type Association’ dialog comes up

i Source Type Aszociation
Source type Lanauage profile

*MOME :ﬂ ASH ﬂ

BaS BAS sl

BMD C —I
C 400 [oaT

CEL CEL =HaEls
CELLE = CEL400

o ol C AN

Bk ) |y

OF | Eancell Help |

3b. From the *Source type’ list box (on the left) select the RPGLE source type. Notice how the
RPGL E400 language profile gets selected in the ‘ Language profile’ list box (on the right).

3c. Pressthe *OK’ button to dismiss the ‘ Source Type Association’ dialog

NOTE: In Step 2 of this section you associated the RPGL E source type with the * . RPG name
pattern. We aso just saw that the RPGL E source type is associated with the RPGL E400
language profile. This actually means that whenever we open aloca file with the .RPG
extension, editor commands and macros in the RPGL E400 language profile get executed!

CODE - Advanced Topics 17 © Copyright IBM Corp. 1998, 2002
Course material may not be reproduced in whole or in part
without the prior written permission of IBM.



CODE - Advanced topics. HandsOn Lab

Step 4. Executing existing REXX macros

PURPOSE

To get comfortable with running REXX macros from the CODE editor you will now execute two
macros that are currently shipped with the WDT/400 product. In order to execute a REXX
macro you have to switch to the editor’s command line. Use the ‘ESC’ key to switch between the
source editing area and the command line.

EEDDE - «TORAS209:BERESTET/QRPGLESRCIEWCS05... M=l B3

File Edit iew Actionz Optiong: ‘Windows Help: Extraz

s [ = = e % I8 R | T 2 R

<TORAS2089:BERESTET/QRPGLESRCG{EWCS A5 )

Row 13 Column 1 Insert 18 changes.
B....CLONB1NBZHAZFactor1+++0pcdeFactor2+++Res)

ga1168 C Z-ADDA@ Dr:_l

ag12a8 C* Here is a comment. - HH

S G 0 Source editing area

goi4ae C app 6 Iy

ag1sa8 C ADD 4 b

1| | 3

Command line

[MACROD EXTRAS OM

REXX macros are run from the command line by typing: MACRO M acroName.
If you are certain that there is no other editor command that matches the name of your macro then
the M ACRO directive can be omitted.

INSTRUCTIONS

Partl. Running a simple REXX macro
4al. Pressthe Esc key to go to the editor’ scommand line.

4bl. Type MACRO EXTRAS ON and then press Enter.

Y ou have just run your first editor macro! The EXTRAS macro is used to update the path

that the editor searches when an editor command or macro is executed. By issuing the command,
"EXTRAS ON" the editor will search product directoryAEXTRAS and then

product directory MACROS. It remains on until it is explicitly turned off (EXTRAS OFF). The
EXTRAS directory contains the additional macros that you are about to play with. Once the
editor window gets refreshed, for example after an Open, you will see a new menu item called
‘Extras.
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4cl. Open afile using the Editor’s Open dialog (File -> Open, expand OS400, expand
CODELABxX, select QRPGLESRC and select PAYROLL) or by typing the following
command in the editor command line

LX <OS400>CODELABxx/QRPGLESRC(PAYROLL)

where ‘xx’ is your workstation number and press the Enter key. LX isthe editor command
used to open afile.

EEDDE - ¢05400:CODELABO1 /QRPGLESRCIPAYROLL)
File Edit “iew &ctions Ophons Windows Help Extras

Row 33 Column 31 Replace

_____ DHamE+++++++++++ETD§Frum+E+Tu{L+++Iﬂc_Heywurd5++++++++++++
88831 D= -
aaan32 D+ Compile time array containing error descriptions.
000833 [ ERR 5 ca DIM{18) CTDATA PE
00834 E=
gpap3s E******************************************************',
iJ | b

| =}

1% <oshf@Bf>codelabB1/qrpglesrc

Extras on

NOTE: Clicking the down arrow in the right hand corner of the editor command line will give
you a selection list of the recently-issued editor commands. Just click on a command to recall it
and press Enter to re-submit it with or without prior modification.

4dl. Enter about 10 lines of text into the file. It doesn't matter what it is.

4el. Go to thefifth line and delete it by pressing Ctrl+Backspace.
Notice that the sequence numbers now skip the number of the deleted line.

4fl. On the editor command line type MACRO RESEQ and then press Enter.
This will resequence the file using the values in the Set Resequence Options dialog
available from the ‘Options‘ -> ‘Resequencing’ pull down.
Notice that the lines are in sequential order again.

4gl. RESEQ isamacro written in REXX. Type:
LX RESEQ.LX
and then press Enter to open the macro and see what it does.
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EEDDE - HAPROGRAM FILESAMBMAWDT400AMACROS vrezeq.In

File: Edit Miew Actionz Ophiong Windows: Help: Estraz

] =] =) ) | R R L |

H:%PROGRAM FILESNIBMAWDTLAAWMACROS\F

Row 1 Column 1 Insert
=———+————1————+————2————+————3————+————u————+————5————+————ﬁ————

Bﬂﬂﬂﬂi’* RESE(] INCR START =/ e

appaz2

AB0A3 "EXTRACT PREFIXFORMAT INTOD FORMAT®

gAAA4if FORMAT <> '9999903XXXXX’ then do

aaaas "EXTRACT HAME®

gaaas say ‘RESEQ.LX: File' HAME ‘does not have sequence numbers
aaeay exit

Aaans end

60009

B8818parse arg IHCR START .

aaa11

ABB12/= if the parms aren't specified, check global wariables =/
BBB13if IHCR = '° then

gaa1y "ESTRACT GLOBAL .RESEQOPT_IHCR IHTO IHCR®

BAB15if START = ' then

aaa1o "EXTRACT GLOBAL .RESEQOPT_START IHTO START'

gag17

BAA18/* now use the same defaults as LPEX =/

886819if IHCR = '° then

gaa2a IHNCR = 188

BEB21if START = ' then

gap22 START = IHCR

aaBz23 l_
BA024 ' PREFIXREHUMBER' IHCR START

I TI

Thisiswhat the macro RESEQ looks like. It may seem allittle cryptic now, but once we take a
closer look, macros will not seem mysterious any more.

Switching between files:

Multiple files can be loaded into the CODE editor simultaneously. In order to switch from one file
to another, there is adrop-down list which is located directly under the toolbar. When you click
on the down arrow on the right, the entire list shows up and you can select the file from there.
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%] CODE - E:\WDT400' MACROS reseq.Ix

;tummand Shell
<054B88>CODELABXX /QRPGLESRC(PAYROLL )

Untitled Document 1
8883 "EXTRACT PREFIXFORHMAT INTO FORMAT® {MJ

Part 2. Running a REXX macro with prompt
At times it may be required to prompt the user for some information. REX X in conjunction with
the CODE editor commands allow for a simple, one-line prompt box, which is good enough for

many cases. Let’stry an example:

4all. Notice that EXTRAS is still ON from the previous exercise. Play with the options that are
available from the ‘Extras’ menu. Y ou can get more information about the supplied ‘extra
features by exploring the ‘CODE/400Tips and Techniques available from the ‘Extras ->

‘Information’ menu.

bll. Pressthe Esc key to go to the command line if you are not aready there.

4cll. Type MACRO RENAME and then press Enter. The following dialog box comes up:

Fename File I

Enter new name:

ok | cancel| Help |
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4dll. Enter RENAMED.DAT inthe 'Rename File' entry field for the new file name and then
pressthe ‘OK’ button.

4ell. The'Rename File' dialog disappears, and the file that is currently loaded in the editor gets
the new name- RENAMED.DAT

%1 CODE - RENAMED DAT IS [=1 E3
File: Edit Miew Actions: Optionz: Windows: Help

SIEEE] ]

Row 1 Column 1 Insert

=———+————1————+————2————+————3————+————l;————+————5————+————ﬁ————+——-
00081 /+ RESE(Q INCR START =/ & |
apae2

88803 ' EXTRACT PREFIXFORMAT INTO FORHMAT®

A88A4IF FORHMAT <> '999999XXXXXX' then do

BaBaas "EXTRACT HAKME®

aaaa6 say "RESEQ.LX: File®' HAME ‘does not have sequence numbers’
aaaay exit

aaang end

60009

#8811 8parse arg IHCR START .

aaai1

ABB12/= if the parms aren't specified, check global variables =/
BAA13if IHCR = '' then

aaaly 'EXTRACT GLOBAL .RESEQOPT_IHCR INTO IMCR® =

I vl

4fl1. Asyou might have suspected aready, RENAM E is another REXX macro. Type:
LX RENAME.LX
and then press the Enter key to bring up its source in the editor.

4gl1. While looking through the source, pay particular attention to the following lines

'set lineread.title Rename Filé
'set lineread.prompt Enter new name:'
lineread 255'

These lines mean:
1) Set the didog title to “Rename File”
2) Create adialog label called “Enter new name:”
3) Read up to 255 characters from the entry field.
Y ou will use similar code in the following exercises when the need for a prompt dialog box arises.
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Step 5. Creating an RPGPROC macro

PURPOSE

Commenting code is seldom done well. Programmers are usually too busy just trying to write the
code and make it work to ever have time to go back and add comments. But leaving out
comments makes code maintenance difficult. What if we could somehow automate this process?
Let’swrite alittle REXX macro that prompts the user for the procedure name and then generates
an appropriate procedure template that includes lovely comments!

INSTRUCTIONS
5a. Pressthe Esc key to go to the command line if you are not already there.
5b. Open anew file called RPGPROC.LX by typing
LX RPGPROC.LX
and then pressthe Enter key.

5c¢. It is necessary to start every REXX program with a comment. The first few lines will give a
brief description of what our macro will do. Type them in:

EEDDE - HAPROGRAM FILESAMBMAWD T400AMACROS \rpgproc._ Iz

Row 1 Column 1 Insert
=———+————1————+————2————+————3————+————h————+————5————+————ﬁ————

BHB B 7 53036 36 3636 36 36 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3636 3 ~

aBae2 7= RPGPROC.LX =]

aa8a3 /= =f

BA8B4/= This macro builds an RPG procedure template =/

Baaas /= =f

HBAHG / * x X XXX XXX X XXX XXX XXX XXX XXX E XXX XXX XXX XXX XXX XX RE X XS] -

4 | b

H:\PROGRAM FILESA\IBHA\WDT4BB\MACROS\rpgproc.lx saved

I TI

5d. At this point you should save the file. Use the ‘File'->’ Save as...” command and add the file
to the WDT/400 macros directory:
x:\WDT400\M ACROS\RPGPROC.LX
(x isthe drive where CODE isinstalled).
Now you can actually run this new macro. Of course, it won't do anything yet because the macro
only contains comments.
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5e. Switch to the command line (press the Esc key) and type MACRO RPGPROC and press
Enter. Nothing happens, the macro does not do anything yet.

5f. Just to get more comfortable with the REXX environment, let’s make a syntax error in the
REXX program. On the first line remove the first forward dlash ‘/’ character, so that the line
becomes:

*************************************************/

Notice that as soon as you move the cursor away from the first line, the line is highlighted in
red indicating that thereis a REXX syntax error.

Row 2 Eulumn 1 InSErt 1 change

= ——————————————————————————————————————————— +————f———=
e e e e e e s .
BaBE2 /= RPGPROC.LX
aaAR3 /= *f
BAABA4 /= This macro builds an RPG procedure template =/
BBABL /= =/
HBAHG / * x X XXX XXX X XXX XXX XXX XXX XXX E XXX XXX XXX XXX XXX XX RE X XS] -
< | ;

| -

5g. Savethefile - thistime use the ‘ Save’ icon on the toolbar.
It looks like this:

Switch to the command line (press the ESC key) and type MACRO RPGPROC and press
Enter. You will get the following error message that indicates that there is a problem with
your REXX program.

CODE - E¥FI303E - Error I

REs=Sa4 eror -35 [H:5Program FileshIBMSwW DT 4004 acroshipgproc. =] - BER may fail

NOTE: If you want more information about an error when running a macro, select Macro Log
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from the editor’ s Windows menu.
5h. Correct the error by putting the */’ character back at the beginning of the first line.

Now we will write some REXX code that will show a prompt dialog box that will look like the
following
RPG Procedure name I

Enter the name of the procedure:

oK | cancel| Help |

As amatter of fact, we have already seen similar code in the previous exercise, but at this point it
would be very helpful to learn a bit more about the lineread editor command.

5i. From the editor’s ‘Help’ menu select the ‘Editor reference’ option. The online Editor
Reference manual comes up in a browser and displays the navigation page Editor Commands
and Parameters. We are interested in information about the command and parameter
lineread. Click on *Commands Summary’ and page down. Click on the ‘lineread’” command
to display the description and carefully read the documentation and example.

#¥ Commands Summary - Netscape
File: Edit “iew Go Communicator Help
T At ¢ S 5
i Back Fomward Reload Home Seach  Guide Frint  Secunty  Siop
le _Q&'Bou:ukmarks )fg Locatiu:un:ittp:f’.-"localhu:ust:4921 3/cai-bindvahweby exedvahelpdy 3400/ wtract A0/ pes/ref flcomref. htrtop j
CTIEW Displays or creates the specified file wew.
help Eetumns help mformation on a requested command or parameter.
nsett Inserts a text string after the current line.
keyread W aits for a ley to be pressed. _J
lineread Produces a dialog that reads a sting of characters. .
load This command reads a specified file (no lines wader than 2500
characters) into an empty Editor window as a simple list of
elements.
Ix Loads or creates the named file.
lxc Issues command as though from the command line. x|
2] [Document: Done S e A
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5j. Use the Back button in the browser’stool bar to get back to the command selection. Page all
the way up and press the Synchronize button in the top right corner. An index and a search
entry field appear. Type ‘lineread ’ in the search field and press Enter. Select the entry

‘Editor - lineread parameter. Read the documentation and examples. Minimize the help
window, we will need it again later.

The following lines of REXX code will set up the dialog box title, a prompt label, and an entry
field of length 10:

'set lineread.title RPG Procedure name

'set lineread.prompt Enter the name of the procedure: '
lineread 10"

5k. Now that we understand how to show a dialog box, we still need to figure out how to read
the  procedure name that the user has entered, and which button, OK or Cancel, was pressed.
We will not worry about the ‘Help’ button. Y ou could find out how to do this by reading the

Editor Reference for the ‘lastline’ and ‘lastkey’ commands. Or you could simply use the
following two lines:

‘extract lastline /* Read in the text from the entry field */
‘extract lastkey' /* Read in the last key pressed */

Once the dialog is dismissed the variable lastline will contain the procedure name and the variable
lastkey will indicate which button was pressed.

NOTE: The ‘Esc’ key corresponds to the ‘Cancel’ button press.

5l. Some error checking never hurts. Let’s make sure that the user actually entered the procedure
name and pressed the OK button, otherwise generate an error message.

if ((lastline="") | (lastkey = 'ESC)) then do
'msg Request canceled'
exit

end

Notice that we used the if - then REXX construct. REXX documentation is available for those
who are not very comfortable with the REXX language. From the editor’s ‘Help’ menu select the
‘REXX help’ option. You will find the * Programming guide’ and ‘Reference’ manuals.
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NOTE: We have gathered all the required information from the user, and are ready to create an
RPG procedure template. We will use the insert editor command and so it is a good ideato read
the appropriate page of the Editor Reference.

5m. Since RPG is a positional language it is important to make sure that the length of the
procedure name variable is no longer than 10 characters. The following code will pad the
procedure name entered by the user with blanks (to exactly 10 chars).

procName = lastline
/* Pad procName with blanks to make it 10 characterslong */
do procLength = length(lastline) to 9

procName = procName' '

end

5n. Any REXX substitution variables should be placed outside the quotes, while editor
commands and strings should be surrounded by single quotes. The fina template generation part
of the macro will look like this:

/* The procName is 10 characters long including blanks */

'INsert  D* —----mmmmmm oo '
'insert  D* Prototype for procedure: ‘procName
'INsert  D* —----mmemmm oo '
'insert D 'procName’ PR’

'insert '

Insert  P* cmcememm e '

'insert  P* Procedure Name: 'procName
'insert  P* Purpose:’

Insert  P* -ooomeme e '
'insert P 'procName' B’

'insert D 'procName' PI'

'insert '

'insert  C* Your calculation code goes here'
'insert '

'insert C RETURN'

'insert P 'procName' FE'

Note: Since the macro will later insert these lines into an RPG source file, the spacing should be
exactly as shown to match the RPG columns. There are 6 blanks between insert and the
specification entry.

CODE - Advanced Topics 28 © Copyright IBM Corp. 1998, 2002

Course material may not be reproduced in whole or in part
without the prior written permission of IBM.



CODE - Advanced topics. HandsOn Lab

After putting al the pieces together your code should look like this:

EEDDE - H-Aadtzwinsmacros\ripgproc.lx =

File: Edit Miew Actionz Optiong: Windows Help: Estraz

= = e ¥ hd

Row 7 Column 1 Insert 2 thanges.

=———+————1 -3 +--——4---—+--—-5 - ———-F—-
HOHB] /% 2 X X A XXX E XXX E XX R XX LA E X AR AL XX E XX AL AR XXX XXX S _:J
gaae2 /= RPGPROC.LX =f
28883 f = ®f
ABAB4/ > This macro builds an RPG procedure template *f
800as /= =f
BARHG f x x X X XXX XXX XX XXX XXX XXX L XX XXX XXX XXX XX XXX XXX XXX XEXXES
BAAB7 ' set lineread.title RPG Procedure name' /= Set dia
BOBB8'set lineread.prompt Enter the name of the procedure: /= Prompt
0682 lineread 18 ° /* Create
AABA18 extract lastline’ Fx Head te
88811 ' extract lastkey® F* UWhat ke
gae12
BAB13if ({lastline = '') | (lastkey = "ESC'}) then do

age1y ‘msg Request cancelled®

BAA1S  exit

ageib6end

aaa17

BAB18procHame = lastline

88819/= Pad procHame with blanks to make it 18 characters long =/
A8828do procLength = length{lastline) to 9

#8821 procHame = procHame® °

AAA22 end

BBB23/* The procHame is 18 characters long including blanks =/
BAO24 " insert D*® ———————— '

B8825 " insert D= Prototype for procedure: ‘procHame

BAB26°" insert e e e :

B8827 "insert D 'procHame® PR’

88828 " insert !

88629 'insert = A !

AAA3A" insert P= Procedure Mame: ‘procHame

ABA31° " insert P* Purpose: '

BAB32° " insert P* ——————— )

88833 " insert P ‘procHame'’ B'

BBAB34 " insert D *procHame® PI*

88035 " insert .

80836 " insert Cx Your calculation code goes here'

88837 "insert :

BAA38 " insert C RETURH'

BBAB39 "insert P ‘procHame’ =
y | ‘B
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Once thefile is saved, we are ready to test out the new RPGPROC macro!

NOTE: Because executing the macro will actually alter the contents of the current file, it isa
good ideato create a brand new local RPG file, say TESTFILE.RPG in the editor.

NOTE: If you have not performed Step 3 of thislab “ Associating name patterns with source
types’, please do so now. It isimportant to make sure that the editor views the TESTFILE.RPG
asan ILE RPG file (the default is RPG/400)!

50. On the editor command linetype LX TESTFILE.RPG and then press Enter.
A new file, called TESTFILE.RPG is opened.

5p. To make sure that the CODE editor thinks of it asan ILE RPG file, bring up the ‘File
Properties dialog fromthe ‘File’ -> ‘Properties...” editor menu.

i File Properties
Suster LOCAL
Hame ‘TESTFILE RFG
Source tpe BEGLE =
Descriptian l
Record length ||:| Ij
[T Contains sequence numbers
Ok I Cancel I Helpl

Notice that the field * Source type’ contains the value RPGLE. This means that the currently
loaded fileis an ILE RPG file. If necessary the value could be changed right here.

5q. Click the ‘Cancel’ button to dismiss the dialog.
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5r. To run the RPGPROC macro, go to the editor command line and type MACRO RPGPROC

and press the Enter button.
The dialog box comes up prompting the user for a procedure name:

5s. Type MyProc in the entry field to specify a procedure name and then click ‘OK’. Asaresullt,
a procedure template is generated. Notice that the name of the procedure is MyProc. WOW!

RPG Procedure name I

Enter the name of the procedure:

oK | cancel| Help |

g5 CODE - TESTFILE.RPG - M[=] 3

Row 1

000061
80602
80603
00804
00005
80006
000067
po008
00009
8e810
80611
00612
08613
80814
80015
80616
00017

File: Edit Miew Actions Options Windows  Help: Estras

Column 1 Replace 5 changes.

b --—-——————————_
Dx Prototype for procedure: MyProc

b - — -
I MyProc PR

PE - - - - - - - - -\ -4" o0 i i b i b i i oh——_————. —_——

P= Procedure Mame: HyProc
P* Purpose:

P - — - ———— -
P HyProc B
I MyProc PI

C* Your calculation code goes here

C RETURH
F MyProc E

‘i

Note: If any of the lines are marked by an error message, your template is causing a syntax error.
Most likely the columns are misaligned. Correct the error and move the cursor off that line to get

the syntax checked again. Don’t forget to change the corresponding line in the macro!
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Optional exercise - prefilling the procedure name entry field

This exerciseis for those who feel fairly comfortable with REXX programming and the editor
commands. It’s okay to skip this part.

PURPOSE
Notice that when the prompt comes up (instruction 5r), the ‘ Procedure Name' entry field is

empty. Sometimes it is useful to prefill an entry field with some default value.

INSTRUCTION
Modify your REXX macro so that the * Procedure Name' entry field contains the value
MYFOO
when the prompt dialog comes up.
|

RPG Procedure name
Enter the name of the procedure:
|MYFOO|

oK | cancel| Help |

—

L
=

Read the lineread editor command in the ‘ Editor Reference’ manual.
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Step 6. Updating the editor’s menu bar

PURPOSE

Once the REXX macro is written you can invoke it from the editor command line. However, for
frequent use this may become tedious. In such cases, we can use the editor commands to create
new menu items. One of the command’ s parameters is the name of your macro. When the menu
itemis selected, the macro is run.

In this exercise you will create the menu item: ‘Extras ->‘COMMON’ -> ‘RPGPROC’.
Y ou will associate the RPGPROC macro with it and then set the *Ctrl + Z’ key combination as
its shortcut.

INSTRUCTION

6a. Usethe ACTIONBAR editor command to create a new menu item. Thisis agood time to
browse the * Parameters Summary’ of the ‘ Editor Reference’ manual and get familiar with
this command.

4'-"-'—— actionbar parameter - Netscape

File: Edit Miew Go Communicator Help

2 =2 A o 2 £ S &£ @ m
Back Fopward Reload  Home  Search Guide Print  Secunty  Stop
-&v Bookmarks A{ Location: i:f'.»'luc:alhu:ust:4921 3Afcgi-bindvabwebe exesvabelp a4 00/E stract /0 pex/ref frlactbrp. hirdftop L‘

i

actionbar parameter

=ets the contents of the Editor menu-bar and associated pull-down menu items,
scope: File

Syntax

set actionbar.{Item| BITHAP_resdll_id} [.{Subitem| BITHAP_resdll_id}] [aoaridd]
[Ordinzl Number] [ Command]

query actionbar.{Item|BITHAF resdll adi[.{Subitem|BITHMAP resdll adi][...]

Options
ftem Mame of the memu ttem to be mcluded on the memi-bar,
i
=] | Bacument: Done S =R s
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6b. Switch to the editor command line and type the following command:
SET ACTIONBAR.E~xtras~COM M ON.RPG~PROC\tCtrl+Z MACRO RPGPROC
and press Enter.

The resulting menu item will be:

! Extras

Disable Extras

lni:curmatiu:un
File
Host Cormmand 7, (e Rt | RS el
Change Management Tools
Highlight line

v Column sensitive editing
Fields r

CoOoL!

NOTE: The‘~' character creates a mnemonic for the menu item, while ‘\t’ defines an
accelerator key for the menu item. Interestingly enough, ‘RPG~PROC’ and
‘RPGP~ROC * are considered to be different menu items.

6¢. At this point you can play with the newly created menu item, and the shortcut key. Make sure
that they behave the way you expect them to!
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Step 7. Updating the editor’stoolbar and
popup menu

PURPOSE

Sometimes programmers like to get fancy and impress their bosses and colleagues. For such
occasions, the CODE editor gives you commands that allow you to update the editor’ s toolbar
and popup menu with the items of newly created macros.

In this exercise you will add a new button to the editor’ s toolbar and a new item to the popup
menu. Both of them will again invoke our famous RPGPROC macro.

INSTRUCTION

7a. Usethe TOOLBAR editor command to add a button to the CODE editor toolbar.
Browse the ‘ Editor Reference’ manual to get familiar with this command.

7b. Go to the editor command line and type the following command:
SET TOOLBAR.RPGPROC BITMAP 33 HELP " RPG proc template’ 4 MACRO
RPGPROC

and then press Enter.

The following toolbar item appears in the fifth position from the left:

ECDDE - TESTFILE.RPG = | [Of ]
File Edit “iew Achons Options  ‘Windows Help  Estras

TESTFILE .RPG

Row 1 olumn 1 Replace &5 changes.

: E (LI . A S SO | D S
aaa81 -
a0882 S S e e e e S
40063 D= Rrototype for procedure: HyProc |
aaaay Dol
aeaes I MEProc PR -

|

New Toolbar Button

Notice that in this example you used the value _33 for the BITM AP option. Bitmaps shipped by
CODE areintherange _1to 38 (the underscore character * ' isimportant). Bitmaps can also be
loaded from your own resource DLL. See the ‘ Editor Reference' for more detalls.
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Popup Menu: An example of apopup menu is the menu list that is displayed when the right
mouse button is pressed while the mouse pointer is inside the CODE editor. The menu list
contains various editing menu items. For example: ‘Cut’, ‘Paste’, ‘Find selection’, etc.
Thislist can be modified by the user. Y ou will do that next.

7c. Use the POPUPM ENU editor command to add items to the CODE editor popup menu.
Browse the ‘ Editor Reference’ manual to learn about this command.

7d. Go to the editor command line and type the following command:
SET POPUPM ENU.RPG~PROC MACRO RPGPROC
and then press Enter.

Now, when we bring up the popup menu the item RPGPROC is added:

EI'.I'IFJF - F-vappshihmyadrzwin' sy stemoone tpng

Row 24

g8piy
0anis
Beb16
[1: 50 i
- R E
BEA19
] Ji e
L]0 P |
gRp22

Ble Edit Yew Actiore Opliohs 'pdows Hep  Esraz
2 B B o S B 1l
Column 1 HI!"]l.EII:I!'
PHamp++++s+334+564+ _ PB.... .. .cccicancnns Heywurd54++++4l--l-
F MUFroc B EXPORT t!
{50 B PI ik @
[Exe i 2B 1n
Fasie Chley
Find s=leshion 5 18 8
[Sgsgent ol
Hilter 2kt lon code goBs hera
ey e ] | Bk

a8pz3
- el

MuliFia Eazich

RETURH retField
E

i

FPGEAUC e s NEF'ltEI'II 3 -

'I

7e At this point you can play with the newly created toolbar button and popup menu item.
Make sure they both behave the way you expect them to! Cool stuff!
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Step 8. CODESRYV - remote execution
command

PURPOSE

The CODESRV command is a workstation command that can be used to:

* Get alist of the active host CODE servers

* Send commands to the iSeries

* Download and upload source

* Get lists of objects that match a specified filter.
The CODESRV command isjust like any other DOS command. Y ou can imbed the command in
your files and do all sorts of interesting things.

In order for the CODESRV command to become really useful, we must make sure that the CODE
communication server is started (see Step 1).

To see how CODESRYV works, open an M S-DOS Prompt window and follow the exercises on
the next page.

&' | Command Prompk

Microsoft Windows Z2HBB [Uersion 5.88.21951
C(C>» Copyright 1785-2888 Microsoft Corp.

Cisres

E:%>cd wdt4d8
E:~WDT 488 >CODESRU

NOTE: Inthe following exercises when we refer to the library CODEL ABxx you should
substitute xx with your workstation number (i.e. 01, 02, 03, ..., etc.).
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INSTRUCTION

8a. Inthe MS-DOS prompt ensure that you are in directory x:\WDT400 (x is the drive where
WDT/400 isinstalled). To seethelist of active CODE servers type:
CODESRV SERVER
and then press Enter. Your list should have OS400 init; there may be additional entries.

8b. To print the MSTDSP source member using SEU, type at the MS-DOS prompt:
CODESRV EXEC O$400 STRSEU OPTION(6)
SRCFILE(CODELABxx/QDDSSRC) SRCMBR(M STDSP)
A spool file of MSTDSP is created on the iSeries.

8c. To list al the source membersin CODELABxx/QDDSSRC type:
CODESRYV LIST O$400 “CODELABxx/QDDSSRC(*)”
The result should be:
EMPMST MSTDSP PRIMST REFMST RSNMST End of file or list.

8d. Type CODESRYV ? to get to help for the command.

If you are really ambitious, use CODESRV GET O00... and CODESRV PUT O$400... to
download and upload members to the iSeries. Notice in the help that you can also use the
CODESRV command to shut down all servers (you can have up to twenty connections at atime)
or the connection to a specific server.

NOTE: You can aso invoke CODE tools from the iSeries. The simplest way isto create a
user-defined optionin PDM. For example, to invoke the CODE Editor on a source member you
would use the following syntax:

CALL QDEVTOOLS/EVFCFDBK PARM('37 'Y' 'OS400' '<LOCAL> CODEEDIT
" <server >lib/file(member)" " )

If your iSeriesisrunning VAR5, use:
CALL QCODE/EVFCFDBK PARM('37' 'Y' 'O$400' '<LOCAL> CODEEDIT
" <server>lib/file(member)" ")

More Importantly:

The CODESRV command can be used in your macros to execute remote commands! Let’stake a
closer look at amacro called SEUPRINT which uses the CODESRV command in order to print
the current member being edited on the host.

8e. From the editor command line run the L X SEUPRINT.L X command.
The file SEUPRINT.LX isloaded into the editor:
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/* SEUPRINT - macro to print the current member being edited on the host. It uses the*/
* SEU print option. *

/* Blank out the message line */
Imsgl 1 1

/* Get full name of file being edited */
‘extract name’

/* Get the name of the server, file and member */
parse var name '<' server >'fn'(' mn ')’

/* Drop /ADM from server name if it exists */
parse var server host /' junk

/* Issue error if this is a LOCAL file... */

if host = 'LOCAL' then do
'msg Host Print is not valid for local files.'
'ALARM'
exit

end

/* Prompt user to save source, then print it on host... */
'SAVEALL PROMPT START CODESRYV EXEC 'host' STRSEU SRCFILE('fn")
SRCMBR('mn’) OPTION(6) (LOG'

'msg Member printed using STRSEU. See Command Shell for status.’

Notice that the CODESRV command is used to submit the SEU print option (OPTION (6) ) to
the iSeries host.
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Step 9. CODE editor profiles

PURPOSE

The menu items, toolbar buttons, and shortcuts that you created in the previous exercises will
only work for the current edit session. If you open a different file or start a new edit session the
menu items will not exist and the shortcuts will do nothing. To make these changes to the editor
more permanent you can use ‘profiles. A profile is nothing more than atext file containing
editor commands. Some of the profiles supplied with the editor provide specific editing features
and run automatically at specific times.

Profile When doesit run? Can | changeit ?
PROFINIT.LXU When the editor starts. Yes
PROFSY S.LXU Just before each file is loaded. Yes
xxX.LXL; xxx=chl, |After PROFSY S.LXU, but before afile of No
rpgled0o, etc. type xxx is loaded.
XxX.LXU After xxx.LXL but before thefileis Yes. Add your own Xxx
loaded. specific commands here.
PROFILE.LX The last profile run before each fileis Yes
loaded.
XXX.LXS Whenever afile of type xxx is saved. Yes

We will take a closer look at the RPGLE400.LXL profile, and will create an RPGLE400.L XU
profile, adding all of our menu and toolbar button creation commands to it.

INSTRUCTION

9a. From the editor command line execute the L X RPGL E400.L XL command to load the file
RPGLE400.L XL into the editor. Alternatively, you could use the open dialog by selecting File
-> Open... expand Local, expand the drive where WDT400 is installed, expand WDT400, click
on macr os, scroll down to rpgle400.1xI and double click on it.

9b. Look through the file. It contains various editor commands that run when an ILE RPG file
getsloaded into the editor. Let ustake a closer look at some of them:
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/* initial fonts settings */

'SET FONT.A BLACK/WHITE "Page™
'SET FONT.B GREY/WHITE "Line
'SET FONT.C BRIGHT RED/WHITE "Spec"

Setup initial fonts for various language constructs...

'SET FULLPARSE SUBMIT READ STOP "Parsing file" ILEPAR ALL'
'SET PARSER ILEPAR'

Parse the file using parser type ILEPAR...

'SET ACTIONBAR.LP_VIEW.S~how. 2 ;'
'SET HELP. 16054

'SET ACTIONBAR.LP_VIEW.S~how.~Control ;INCLUDE CONTROL;SET E

Create some menu items...

'SET ACTIONPREFIX.F ;SET PREFIXENTRY;ILEPAR Q'
'SET ACTIONPREFIX.F?;SET PREFIXENTRY;ILEPAR O'
'SET ACTIONPREFIX.P ;SET PREFIXENTRY ;ILEPAR PROMPT"

Create ILE RPG specific prefix area commands.

CODE - Advanced Topics 41 © Copyright IBM Corp. 1998, 2002
Course material may not be reproduced in whole or in part
without the prior written permission of IBM.



CODE - Advanced topics. HandsOn Lab

9c. At this point we will create an RPGLE400.LXU profile. It runs after RPGLE400.L XL, but
before an ILE RPG file isloaded. We will use this profile to add the menu options and toolbar
buttons associated with the RPGPROC macro whenever an ILE RPG file is loaded!
On the editor command line type:

LX RPGLE400.LXU
and then pressthe Enter key.

9d. Add the following familiar linesto the file.

EEUDE - H:APROGRAM FILESAMBMAWD T4000MACROS Mipgle400_lxu

Eile: Edit Wiew Actio
 !“=£§;51:w Kl 1%

nz Optionz Windows: Help: Estraz
EEEREED ORE

pgles80.1xu

Row 1 Column 1 Insert
=———+————1————+————2————+————3————+————1;————+————5————+————ﬁ————+————?————-|

B EBET /236963636 3636 363630 3636 36 3636 636 3 636 3636 36 3636 6 36 336 M3 I3 I XK HHE XXX HH S

BAAA2 /= RPGLELAB.LEU - Language-sensitive, user-defined =/

a8ee3 /= editor profile for ILE RPG =/
BOABANf xR R XX R XX EXE XXX L AR EERERE X R XX XXX EXEXEEREREXRRXER]
aaaas

BBABG6/* Setup the menu, toolbar, and pop-up menu items =/

ABAB7 'SET ACTIODHBAR.E™Xtras.™RPGTools .RPG™FrocTemplate’tCtr1l+Z HACRO RPGPROC®
ABABE ' SET TOOLBAR.RFGProc BITHAP _33 HELP "RFG proc template'™ 4 MACRO RPGPROC®
88689 "SET POPUPMEHU.RPG™Proc MACROD RPGPROC'

| -

9e. Savethefile indirectory
x:\WDT400\MACROS
Close the editor using the ‘File’ -> *Exit’ menu option.

9f. Bring up an MS-DOS Prompt window and run the following command:
CODEEDIT COMMON.RPG
which brings up the editor and creates a new file COMMON.RPG.

The menu items, popup menu item and toolbar button associated with the RPGPROC macro are
available now. The RPGLE400.LXU profile that you just created ran just before the editor loaded
the ILE RPG file! Remember that in step 2 of the exercises we associated the name pattern * .RPG
with the source type RPGLE and that the source type RPGLE is associated with the RPGLE400
language profile.

NOTE: Itisnot agood ideato make changes to the xxx.L XL files because they get replaced
once the workstation is updated with a new release of CODE. xxx.L XU files on the other hand
are left untouched and that way your changes ‘survive' the CODE update!

9q. Close the CODE editor.
This section of the lab is complete!
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The Lab = Section 2: Lpexlets

Section I ntroduction

In this section we will learn how to program the CODE editor using the Java language.
Javais an object oriented programming language that is, compared to other OO languages like
C++, relatively “easy to digest”. Over the course of the past few years a large number of Java -

related terms have emerged:
¢ JavaBeans
e Cookies
* Applets
*  Servlets
So, not to fal far behind, CODE added its own Java - related term: L pex|ets.

They are extensions to the CODE editor written in Javathat allow a much richer set of GUI
components than REXX macros. In this section we will write avery simple Lpexlet that provides
the GUI interface for the RPGPROC macro. The Lpexlet will only take care of gathering the
information from the user and will then call a REXX macro to generate an RPG procedure
template. (The REXX part has aready been implemented in the previous section).

To run your Lpexlet, you use the RUNJAVA Lpexlet_Class Name command.

As a CODE user, Java applies to you in the following ways:

* Asalanguage that helps you customize the CODE editor via L pexlets.
* Asaprogramming language for your client user interfaces.
* (Since V4R2), as a programming language on the iSeries.

Java Applets

Java can be used to write applets, which are small programs that can only run inside web browsers
such as Netscape Navigator or Microsoft Internet Explorer. These are mini-programs, but they
have full user interface capabilities. They run right inside the browser. Javais traditionally an
interpreted language, like Visual Basic and Smalltalk, and the web browsers today all include a
Javainterpreter engine.

Java applets can be used inside a traditional HTML (Hyper Text Markup Language) web page to
add logic, graphics or user interaction. They can even be used to access data from a host, such as
DB2/400.
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The key things to remember about applets are:

* They only run inside a browser. They have no “main window” of their own, but rather use the
real estate of the web browser.

* They physically live on the same server as the web page itself. The web browser, upon
encountering an HTML “APPLET” tag inside the HTML source for a web page will return to
the server to retrieve the applet (as pointed to by the APPLET tag), and download it into
memory where it will be run.

* They are not permitted to access the local client’s hard drive or run programs on the local
client. They are also not allowed to communicate back to any host server except the one they
came from (the restrictions can be waived with “signed” applets that are run by consenting
users).

Java applets can target iSeries data and programs. This can be done using built-in Java
communications support for TCP/IP sockets programming, or it can be done using the iSeries
Toolbox for Java set of classes written by IBM Rochester. This Java code offers a significantly
easier means to access iSeries services than raw communications coding.

Java Applications

While the early excitement around Java was due to its unique ability to program web pages with
live code, thisis not Java' s only role. It is also afull fledged application programming language,
and can be used effectively to write full applications, which are invoked from the command line as
with traditional language applications.

Using Javato write applications offers al the functionality and portability benefits of Java applets,
but:

* Removesthe security “sandbox” restrictions that applets have.

* Doesnot offer, yet, the exceptional benefit of being loaded on demand that applets enjoy.
This means distribution and maintenance are bigger considerations, for client Java
applications.

NOTE: TheiSeries Toolbox for Java code can be used for Java applications or applets;
The iSeries Toolbox for Java classes are shipped with WDT/400.

To run a Java application on a particular operating system, you must have a Java Virtual Machine
(VM - interpreter) on that operating system. All current operating systems have now, or will
soon have, a VM huilt into them.

The Java Development Kit (JDK) is required to develop Lpexlets. The JDK or Java Runtime
Environment (JRE) is required to run them. Both are available from JavaSoft's web site

WwWw.j avasoft.com.
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Y ou will:

* Create an RPGProc Java class that extends the L pexCommand class - amust for every
L pexlet.

* Create another new class called RPGProcFrame, that extends JFrame whichisa
Java-supplied class for putting up a dialog and which implements a Java-supplied interface for
handling GUI events.

*  Compile Java classes using the CODE Java class generation mechanism.

*  Writean RPGPROCJAVA macro that reads in data provided by the Lpexlet and generates
an RPG procedure template.

* Runyour Lpexlet from the CODE editor and see the results.

* Play with the ‘RPG Procedure’ SmartGuide.

Thislab is not intended to teach you how to programin Java, however, we will give you pointers
about relevant language constructs along the way. So, if you see Java Reference and END Java
Reference tags, that is where you find Java language hits.

Ready? L et us continue on our journey to CODE L pexlets...
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Step 1. Creating an RPGProc L pexlet Class

Java Reference:

*  Commentsin Javacome in two forms;
* Multiplelines: These start with “/**” and continue until an ending “*/” pair is found.
* Singleline: To put acomment on aline or end of aline, start it with //

* Classes. These, likeiSeries ILE RPG modules, allow you to divide your source code into
functions (methods in Java, procedures and subroutinesin RPG) and variables those functions
need. These are typically self-contained groupings. Classes contain multiple fields (variables)
and methods.

* Methods. These, like iSeries ILE RPG procedures and subroutines, contain all the actual code
your program or application will use. Unlike RPG, in Java executable code can only exist in
methods. And methods can only exist inside classes.

What isaclass? It isakey construct in Java: all code and all variables exist only inside classes. In
fact, code must exist inside methods which must exist inside classes.

Java classes are similar to ILE RPG modules! Modules contain variables and RPG procedures
and subroutines. Java classes contain variables and methods. Methods are like RPG procedures

( variables ) ( variables )

rocedures ~ methods
P W

b g
~ L™
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A classin Javatypically looks like this:

public class Wwd ass
{

/] vari abl es
/1 nethods

}

NOTE the keyword class, and the braces delimiting the beginning and end of the class. In this
example, “MyClass” is the user-supplied name of the class. The Java keyword public indicates
this class is accessible by everyone. Thisis an optional keyword - without it only other classesin
this package have access to this class.

* |Inheritance. One of the main features of every Object Oriented language is the ability to
easly extend aready existing code. In Java, this feature is implemented by the means of
Inheritance. Y ou can write a class (call it BaseClass) that provides some basic services. (By
services | mean Java methods or ILE RPG procedures/subroutines). If a new class that you
are implementing (call it SophisticatedClass) needs to provide the same basic services, and
perhaps even more, SophisticatedClass can inherit all basic services from the BaseClass, and
only implement new functionality.

In Java we use the extends keyword to indicate the inheritance. Here is a typical example:

publ i c cl ass Sophisticatedd ass ext ends Based ass

[l vari abl es
/1 met hods
} /1 end SophisticatedC ass

* Polymor phism is another cornerstone concept of Object Oriented languages. When your
SophisticatedClass inherits from the BaseClass there maybe some methods implemented by
the BaseClass whose behavior you would like to alter. Y ou can override a method. If your
BaseClass provides a method MyMethod( ), your SophisticatedClass can also implement
MyMethod( ) which behaves differently than the inherited one. At run time Java decides
which method to use appropriately. This feature of the Javalanguage is called
polymorphism.

END Java Reference
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PURPOSE

CODE shipsa set of Java classes. Information is available from the ‘Help’ -> *Java help’ ->
‘Lpex Java readme’ menu option. Note that you have to open a Javafile for ‘* Java help’ option
to be available. One of the classes that CODE shipsis called LpexCommand class. This classis
your interface to writing Lpexlets. In this section we will implement an RPGProc class that will
inherit from the LpexCommand class, as must every Lpexlet. In addition, every Lpexlet must
override the method IpexEntry( ) - amain entry point into the Lpexlet. This method gets called by
the CODE editor when the ‘RUNJAVA Lpexlet_Class Name' command is run.

In our case Lpexlet Class Name will be RPGProc and hence the command becomes
‘RUNJAVA RPGProc’. Don’'t run anything yet!

The RPGProc Lpexlet will put up a nice dialog prompting the user for the Procedure Name and
the Programmer Name.

Eéf—_,% RPG Procedure Template _ (O]

Procedure Naimne | |

|
Programmer Name |

| Ok | | Cancel | | Clear

Once al information is entered, the L pexlet will call a REXX macro to generate the procedure
template. The reason for thisis very smple - we aready have code that does this job. So we will
reuse a part of the RPGPROC macro.

INSTRUCTIONS
la. Start up the CODE editor and open the file RPGProc.java. Remember that in Javafile names
are case senditive!

x:\CODELAB\RPGProc.java

1b. Below isthe code for the RPGProc class.
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public class RPGProc extends L pexCommand

{
static RPGProcFrame rpgProcFrame = null;

I* lpexEntry() - main entry point from LPEX. Overrides LpexCommand's. */
public static int [pexEntry (String arg)
{
if( rpgProcFrame == null )
rpgProcFrame = new RPGProcFrame();

rpgProcFrame.setVisible(true);
return O,
} I/ end IpexEntry()

/I Once the OK button is pressed, need to set DOCVARSs
public static int setDocVars(String procName, String pgmrName)
{
IpexCommand("SET DOCVAR.PROCNAME " + procName);
IpexCommand("SET DOCVAR.PGMRNAME " + pgmrName);

IpexCommand("MACRO RPGPROCJAVA");
return O;
} I/ end setDocVars()

I* IpexNotify() - tell LPEX to notify us on exit.
public static int IpexNotify()
{
return LPEX_NOTIFY_EXIT;
} 1/ end of IpexNotify()

I* IpexExit() - we're being terminated, dispose of the toolbar */
public static int IpexExit (String arg)
{
rpgProcFrame.dispose(); // get rid of the dialog
return 0,
} // end of IpexExit

} // end class RPGProc
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Java Reference:

Typically you have only one class per source file (.java), and the name of the class corresponds to
the name of the source file (not counting the .java extension). The source file will be compiled
into one ByteCode (.class) file with the same name as the class. The compiler is called JAVAC
and it converts source into easily interpreted ByteCode.

CODE automates this compilation step, just like for any other supported language. We will see
this feature later in thislab.

* Objects. These are “instances’ of classes, and are necessary to use classes that contain
non-static methods or variables. They are created by defining a variable, specifying the class as
the type, and equating the variable to an instance or allocation of the class using the new
operator in Java.

* Instancevariables. These are non-static variables declared at the class level and available to
al methods in the class. Each instance (object) of the class gets its own copy of these
variables. Compare to global variablesin RPG.

¢ Local variables. These are variables declared inside a method and are local to that method.
They are only “alive’ aslong as the method is running.

* Constructors. These are specia methods that each class can optionally have that are called by
Javawhen the classisfirst “instantiated” (an instance is allocated). They are used to initialize
variables and state, smilar to RPG’s *INZSR subroutine. They are identified by their name -
it is the same as the class.

END Java Reference

NOTE: Theimport statement in Javaislike /COPY in RPG. Hence import RPGProcFrame
means that the file RPGProcFrame.java (which probably defines an RPGProcFrame class) is
included in our RPGProc.java file. As a matter of fact, the RPGProcFrame class defines the user
interface part of this L pexlet. We will develop this class in Step 2 of this section.
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NOTE: Inour implementation of the IpexEntry( ) function (remember that every Lpexlet hasto
override this function!) we create a new RPGProcFrame object and then make it visible using the
setVisible( ) method.

NOTE: We will create a setDocVars( ) method which will be called by the RPGProcFrame class.
We will then use the |pexCommand( ) method of the LpexCommand class to execute the CODE
editor commands. In order to pass the values of the procedure and programmer name to the
REXX macro we need to save these values in the editor variables. They will be retrieved later by
the REXX macro:
IpexCommand("SET DOCVAR.PROCNAME " + procName);
IpexCommand("SET DOCVAR.PGMRNAME " + pgmrName);

Last but not least we will use the [pexCommand( ) function to call the REXX macro
RPGPROCJAVA. This macro - a shortened version of RPGPROC - will be implemented later in
this lab.

Help for the LpexCommand class is available from ‘Help’ -> ‘Java help’ ->
‘LpexCommand help ’ menu option.

NOTES ABOUT TYPING:

* Caseisimportant. Java names are case senditive. “MyVar ” does not equal “nmyvar ”.
* White space is not important. Leave/insert as many blanks as you like.
* Watch for the semi-colons (;) at the end of executable lines of code! They are important.

lc. Take aclose look at the code of RPGProc.java. Pay special attention to the statements that set
the editor variables PROCNAME and PGMRNAME.

1d. Save your file in directory x:\WDT400\JAV A by going to the editor command line and
typing:
SAVE “x:\WDT400\JAVA\RPGProc.java’
and then pressing Enter.
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Step 2. Creating the * RPG Procedure
Template” dialog box - RPGProcFame class

PURPOSE

In the IpexEntry( ) method of the RPGProc class we create an rpgProcFrame object of type
RPGProcFrame that is responsible for putting up the dialog box. Now is the time to implement
the RPGProcFrame class.

Java Reference.

Some Java-supplied classes

The RPGProcFrame class will inherit from the class JFrame. JFrame is a Java-supplied class. It is

responsible for putting up the dialog window and border. Other Java-supplied classesthat are

used by the RPGProcFrame class are:

* JPane. The Object of this classfillsin the space provided by the JFrame. It aso looks after
the placement of all other user interface components.

* JButton. Objects of this class are pushbuttons. (OK, Cancel, and Clear in our case).

* JLabel. Objects of this class are text labels.

* JTextField. Objects of this class are entry fields where the user typesin the input.

I nterfaces

Many Object Oriented languages provide the ability to inherit services from multiple classes.
Thisfeature is caled multiple inheritance. Due to some efficiency and complexity
considerations, Java does not directly support multiple inheritance. However, every oncein a
while, a need for such construct arises. To overcome this difficulty, Java supports a concept
smilar to aclass, called an interface. An interface does not provide services, it only defines them.
A class can implement an interface. Implementing an interface, means implementing all
servicesymethods that a particular interface defines. A class can extend another class and
implement interfaces at the same time. Here is atypical example:

publ i c cl ass Sophisticatedd ass ext ends Based ass
| npl ement s Baselnterface

[l vari abl es
/1 met hods
} /1 end SophisticatedCd ass
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Event Driven Programming in GUI Systems

In RPG you display a screen by writing to one or more record formats, and retrieve data entered
by the user by reading a record format. Reading a display file will return data in the fields and
indicators (which indicate which key was pressed). This is Screen-driven programming. Y our
program writes and reads screens of information.

In GUI environments, it is different. Y our program gets “notified” of every single user action -
pressing a key, pushing a button, moving the mouse, etc.. These actions are called events.

Y our program can choose to process individual events or let the system do its default action for
them (usually nothing). Thisis called event-driven programming

Event Driven Programming in Java
In Java, “events’ are Java objects (instances of Java classes) that are sent to your own classif you
tell Java to!

Howdo | tell Java to send eventsto my class?
Y ou have to do three things (don’'t do these yet, just read):

1. Indicate that your classis capable of responding to these events by including the code
“Iimplements xxxListener” on the class definition, where xxx indicates the events you want to
be informed of. For example, “implements ActionListener” will cause the system to inform
you of action events (versus say, typing events or mouse move events).

2. Supply amethod in your class that will be called for specific events. These methods have to
use the exact names and parameter types that Java defines for each event. For example, for
action events it requires the method “ public void actionPerformed(ActionEvent event)”.

3. For each GUI component, such as a push button, after creating it you must “register” that it is
to send its events to your class. Do thisusing the “ addActionListener(
instance-of-your-class)” method that all input-capable Java components support.

END Java Reference.

INSTRUCTION

2a. Inthe CODE editor open the file RPGProcFrame.java
x:\CODEL AB\RPGProcFramejava

2b. The next few pages contain the source code for the RPGProcFrame class.
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import javax.swing.*;
import javax.swing.event.*;
import java.awt.*;

import java.awt.event.*;
import java.util.*;

import java.io.*;

public class RPGProcFrame extends JFrame implements ActionListener
{
private JPanel contentPane = null;
private JButton cancelButton = null;
private JButton clearButton = null;
private JButton okButton = null;
private J_abel pgmrNameL abel = null;
private JLabel procNamelL abel = null;
private JTextField pgmrNameTextField = null;
private JTextField procNameT extField = null;

[* RPGProcFrame class constructor */
public RPGProcFrame()
{

super();

setSize(426, 240);

setTitle("RPG Procedure Template');

/I Create OK button object
okButton = new JButton("OK");
okButton.setBounds(42, 170, 85, 25);
okButton.addActionListener(this);

/I Create cancel button object
cancelButton = new JButton("Cancel");
cancelButton.setBounds(169, 170, 85, 25);
cancelButton.addActionListener(this);

/I Create clear button object

clearButton = new JButton("Clear");
clearButton.setBounds(296, 170, 85, 25);
clearButton.addActionListener(this);

1

I* RPGProcFrame.java This class creates and handles the Ul for the RPGProc Lpexlet */
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/I Create text label for procedure name
procNameL abel = new JLabel("Procedure Name");
procNameL abel.setBounds(35, 27, 146, 20);

Il Create text label for programmer name

pgmrNameL abel = new JLabel("Programmer Name");
pgmrNameL abel.setBounds(35, 74, 147, 20);

Jf mm e

/I Creating an entry field for procedure name
procNameT extField = new JTextField();
procNameT extField.setBounds(218, 27, 169, 19);

/I Creating an entry field for programmer name
pgmrNameTextField = new JTextField();

pgmrNameT extField.setBounds(218, 74, 169, 19);

[ m e e e

/I Construct the JPanel object - client canvas and add all controls
contentPane = new JPanel();

contentPane.setLayout(null);

[ m e e s

/I Add all entry controls and corresponding Labels to the client pane
contentPane.add(procNamel abel, procNamel abel.getName());
contentPane.add(pgmrNameL abel, pgmrNamel abel.getName());
contentPane.add(procNameT extField, procNameT extField.getName());
contentPane.add(pgmrNameTextField, pgmrNameTextField.getName());

/I Add all button controlsto the client pane
contentPane.add(okButton, okButton.getName());
contentPane.add(cancelButton, cancelButton.getName());
contentPane.add(clearButton, clearButton.getName());

1

1
/I Now that everything is constructed, set the client pane to contentPane
1
setContentPane(contentPane);
1

} /I end constructor()
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/**

* Override actionPerformed( ) method of the ActionListener interface
* If any registered button is pressed, this method gets invoked
*/
public void actionPerformed(ActionEvent evt)
{
Il First of al figure which button was just pressed
String arg = evt.getActionCommand();

if( arg.equals("OK") ) /I OK button is pressed

{
/l Update DOCV ARs to be used by the REXX macro
RPGProc.setDocV ars(procNameT extField.get Text(),

pgmrNameTextField.getText());

dispose(); Il close the dialog

} // end if(OK button is pressed)

elseif( arg.equals("Cancel") ) // Cancel button is pressed

{
dispose(); /I close the dialog

} // end if(Cancel button is pressed)

elseif( arg.equals("Clear") ) // Clear buttonis pressed

{
procNameTextField.setText(""); // Clear the procNameTextField
pgmrNameTextField.setText(""); // Clear the prmrNameTextField

} // end if(Clear button is pressed)

} /I end actionPerformed()

} /I end class RPGProcFrame
[ m e e e

NOTE: Aswe pointed out before, thislab is not intended to teach you the Java language. But

we gtill would like to highlight a few key points.

* The RPGProcFrame class inherits from the Java-supplied JFrame class and implements the
Java-supplied ActionListener interface.

* The RPGProcFrame class implements only two methods:. a class constructor RPGProcFrame(
) and actionPerformed( ).

REMEMBER: A CONSTRUCTOR IS A METHOD THAT HAS THE SAME NAME
AS THE CLASS, AND HAS NO RETURN TYPE.
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In the class constructor we create the dialog window, all dialog controls, and place these controls
inside the dialog window. We also “register” all buttons with our RPGProcFrame class. Whenever
abutton is pressed, an event is sent to the RPGProcFrame class.

/I Make sure client is listening to the button press events
okButton.addActionListener(this);
cancelButton.addActionListener(this);
clearButton.addActionListener(this);

Note: “this’ isa specia Java built-in keyword that represents the current instance of the current
class. So, for example, areference to an instance variable, asin x=10 is equivalent to
t hi s. x=10

The actionPerformed( ) method is defined by the ActionListener interface. Since the
RPGProcFrame class implements the ActionListener interface, it must provide an implementation
of this method. Whenever a button is pressed, an event is sent to the RPGProcFrame class and an
actionPerformed( ) method gets called. We figure out which button: *OK’, ‘Cancel’, or ‘Clear’
caused the event to be generated, and act accordingly...

2c. Read through the code. Try to find all the pieces we talked about.

2d. Save your file in directory x:\WDT400\JAVA by going to the editor command line and
typing:
SAVE x:\WDT400\JAVA\RPGProcFrame.java
and then pressing Enter.
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Step 3. Using CODE to compile your Java
classes

PURPOSE

The CODE editor provides a set of Verify/Compile/Debug actions for any supported iSeries
language including Java. However, Java classes can run on your PC and on your iSeries. CODE
targets both: one for Lpexlet development and the other for iSeries Java development. We
therefore provide two sets of Compile/Run/Debug actions: local and remote.

y lzsue edit command... Esc

l Compare. ..

Eeystioke recorder 3

|::|:|m |:|||E- ||:||:: .E|| 3

Rup lozal ¥ MNoprompt

Debug local ¥ Mo prompt and show command shell Chi+S it
I Create program remote LR ATT ]

Bun program remate 3

Drebug remote 9 LI

Export bora 5400,

Create 3

In this exercise we are developing L pexlets and will therefore concentrate on local actions.

INSTRUCTION
3a. Make sure your current file is RPGProcFrame.java.

3b. From the editor’s *Actions menu select the ‘Compilelocal’ -> ‘Prompt..." option.
After afew seconds (be patient - thisis Java) the following dialog comes up.
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Egﬁ.la\ra Compile Options Dialog

nexpected error running command 'START dappsibmiadiswinyavaljavac...

| Jok options D Release | Other |

Choose target Java Development Kit level

) JDK 1.1.x @ JDK 1.2 or higher

rChoose scope for these settings

| Save seftings as defaults for all subsequent compiles

|[_] Save settings permanenthy for this file

Hext=> Final Cancel ﬂe_lp;

This dialog has severa pages of Java compiler settings. You can use the ‘Next>>" and
‘Previous>>" buttons to navigate between pages. Get familiar with the dialog. Y ou will need to
use it quite a bit once you get into serious Lpexlet development!

3c. The defaults are just fine for now. Pressthe ‘Final’ button and watch how RPGProcFrame
class gets compiled. Y ou will notice a‘Compiling...” message in the editor message area (just
above the editor command line).

NOTE: Once the compile is completed, and if no errors are detected, you will get a‘Compiled
clean’ message in the editor message area. |If your Java class contains errors, an ‘Error list’
window comes up indicating all of the compile errors. Double clicking on an error message takes
you to the line that causes the problem.

3d. Inthe CODE editor switch to the RPGProc.java file.

3e. Thistime we will use ano prompt compile option. From the * Actions' menu select
‘Compilelocal’ ->*No prompt’ option and watch the RPGProc class compiling.

Now all of your Java classes are compiled and .classfiles are generated. Wasn't that easy?

WOW!
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Step 4. Creating the RPGPROCJAVA macro
and running the L pex|et

PURPOSE

We are aimost ready to test out our first Lpexlet but there is one piece of the puzzle still missing.
Remember, we need to call the RPGPROCJAV A macro to generate the procedure template. As
amatter of fact, we can reuse most of the REXX code from the RPGPROC macro.

After that, the testing stage begins!

INSTRUCTION

4a. Open anew file RPGPROCJAVA.LX by typing: LX RPGPROCJAVA.LX on the editor
command line and then press the Enter key.

4b. The REXX code on the next page should look very familiar. The only trick is the use of two
DOCVARs:

/* Read in the DOCV ARs that are set by the Lpexlet */
'EXTRACT DOCVAR.PROCNAME INTO 'procName

'EXTRACT DOCVAR.PGMRNAME INTO 'pgmrName

Remember, we did a*SET DOCVAR'’ inthe RPGProc class? The ‘EXTRACT DOCVAR' is
how we retrieved values stored in the DOCV ARs. This is the data exchange mechanism between
L pexlets and REXX macros.

4c. Type in the following REXX code and save the file in x:\wdt400\macros.
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/************************'k************************/

/ * RPGPROCJAVA. LX

*/
/*
*/
/* Thi s macr o bui | ds up an RPGpr ocedur e cal |
*/
/* tenpl ate.
*/
/* 1t uses RPGProc Lpexl et for pronpting...
*/

/*************************************************/

/* Readinthe DOCVARs t hat are set byt he Lpexl et */
' EXTRACT DOCVAR. PROCNAME | NTO' pr ocNane
' EXTRACT DOCVAR. PGVRNAME | NTO' pgnt Nane

[ * Pad procNanew t h bl ankstomnmakeit 10 characters | ong
*/
do procLength=1engt h(procNane) to9

pr ocNane = pr ocNane' '

end
* The procNanei s 10 characters | ongi ncl udi ng bl anks */
i nsert B e '
nsert D* Prot otype for procedure: ' procNanme
nsert D '
nsert D' procNane' PR
nsert '
nsert e '

[
[

[

[

[

[

i nsert P* Procedur e Nane: ' pr ocNane
i nsert P* Pur pose: '

i nsert P* Wittenby: 'pgnrNane
[

[

[

[

[

[

[

[

/

nsert e e '
nsert P' procNane' B'

nsert D' procNane' Pl

nsert '

nsert C* Your cal cul ati on code goes her e’

nsert '

nsert C RETURN

nsert P' procNane' E

" TRI GGER FULLPARSE'

All the pieces are ready now and we can start testing the Lpexlet.
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4d. Open anew ILE RPG file COMMONZ2.RPG by typing: LX COMMON2.RPG onthe

editor command line and then press the Enter key.

4e. Go to the editor command line and type:
RUNJAVA RPGProc
and then pressthe Enter key.
Note the case isimportant when you call a Java class.

The following Java dialog comes up prompting the user for the procedure name and the

programmer name:

Eéf’,a BPG Procedure Template =l

Procedure Name ||

Programmer Name |

Ok Cancel

Clear

W O wit!

4f. Enter the following values in the entry fields:
In Procedure Name field enter:  MyProc
In Programmer Name field enter: MyName
and press the OK button.

The resulting procedure template is shown on the next page:
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EEDDE-EDHHDH_HPE = Hi=] E3
File: Edit %iew Actions Dption: Windows: Help: Eztras

COMHON.RPG

Row 1 Column 1 Replace 2 changes.

R T (R - PN SR SN U | SR SN SO S

aaaa1 D -———-——-——-"—--————

aapaz2 D= Prototype for procedure: HyProc

aaaa3 D e e e

aapaL D MyProc PR

ap[as

AaAas e il

aaaay P= Procedure MHame: HyProc

Baaag P= Purpose:

aooe9 P= Written by: MyHame

aga1@ e R R R R R R R

aaat P MyProc B

ga|2 I MyProc PI

aRA13

aaaty Cx Your calculation code goes here

aaa15s

aaa16 C RETURH

aaa17y P HMyProc E
I %l

Notice that the generated template is very similar to the one created by the RPGPROC macro.
Thistime, however, the template also contains the programmer’s name. It would be fairly easy to
add other entry fields to the existing dialog to prompt the user for other important pieces of
information.

4g. Fromthe ‘File’ menu select *Exit’ to close the CODE editor.

*** Congratulations! ***

Y ou have successfully completed the Advanced CODE lab. Programming the CODE editor may
have left you bewildered, but you made it. Soon enough you will impress your boss and
colleagues with some cool extensions to the CODE editor!
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Appendix = The RPG Procedure
SmartGuide

This section is not part of the core lab. We just want to show you how fancy you can get with
L pexlets. CODE ships a Java-based SmartGuide framework The documentation is available from
the editor’'s ‘Help’ menu: ‘Java help’ -> * SmartGuide framework’.

One of the samples that comes with CODE is a SmartGuide to generate an RPG procedure
template.

a. Open an ILE RPG file (you can even use COMMON.RPG).
b. Fromthe ‘Actions menu select ‘ SmartGuides -> ‘Create Procedure...”. The following

dialog comes up:

Eg-f, RPG Procedure SmartGuide [ [O]

r 000 1]
[start]

Procedure name: | |

External name (EXTPROC): | |
|_| Exportable for use by other code (EXPORT)

Purpose: | |

[_] Return a value

How many parameters? | o E‘

Provimis Mext>= Firral Eﬂn[:El HE'D

Notice how additional pages appear if you increase the number of parameters or indicate that the
procedure has areturn value. Entry fields colored in yellow must be filled in, the others are
optional.

Play with the SmartGuide, have fun, and good luck with CODE!

CODE - Advanced Topics 64 © Copyright IBM Corp. 1998, 2002
Course material may not be reproduced in whole or in part
without the prior written permission of IBM.



